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Mise en forme

Texte d'intérieur et style

Une fois que votre texte et vos images sont compilés dans un seul fichier,
utilisez les styles et les titres pour créer une apparence cohérente pour les
titres de texte et de section. Utilisez des sauts de page au lieu de retours a la
ligne ou de sauts de paragraphe pour garantir la préservation de votre mise
en forme lors de la création de votre fichier PDF prét a imprimer. Appliquez
vOos propres régles despacement aux styles pour conserver une apparence
cohérente dans tout votre livre. Lutilisation de styles vous permet de modifier
simultanément tout le texte affecté a ce style plutdét que de modifier ligne par
ligne.

Choix des couleurs de l'intérieur

La nécessité d'une impression couleur doit étre prise en compte au début

du processus de mise en forme. Votre ceuvre consiste-t-elle uniguement

en du texte ? Si c'est le cas, vous pouvez profiter de nos produits Blanc ou
Créme, 60# non couchés noir et blanc standard pour réduire les co(ts
de fabrication. Pour des images a contraste élevé et en niveaux de gris, Lulu
propose un Blanc, 80# couché noir et blanc standard. Nos produits
Blanc, 60# non couchés Couleur standard vous permettent d'incorporer
des éléments passionnants tels que des polices colorées, des reflets, des
graphismes, des graphiques, de petites photos ou des blocs de couleur a
faible pigmentation/saturation dans votre ceuvre imprimée sans devoir payer
le service premium.

Sivous souhaitez une impression couleur de la plus haute qualité, l'option
Couleur Premium vous offre la qualité dont vous avez besoin pour des
photos haute résolution et une couverture de page a fond perdu. Disponible
sur du papier blanc 80# couché et non couché, vous pouvez garder un
prix raisonnable tout en affichant de superbes graphismes et des couleurs
éclatantes.

LULU GUIDE DE CREATION DE LIVRE CREATION DE FICHIER 4



Comparaison de résolution d'image

Résolution standard de la Résolution minimale pour Résolution idéale pour

plupart des images lors de les images simples destinées les images complexes
leur affichage numérique. a l'impression. ou détaillées destinées a

l'impression.

Résolution photo et graphique

Les pixels par pouce (PPI) sont utilisés pour décrire la densité de pixels
d’un écran (écran d'ordinateur, smartphone, etc.). Les points par pouce
(DP) font référence a la résolution d'impression dune image en comptant
le nombre de points par pouce imprimé. Plus il y a de points, meilleure est la
qualité de l'impression (plus de netteté et de détails). La plupart des formats
de fichiers préts a imprimer savent comment gérer la conversion entre les
PPl et les DPI. Les PDF vous permettent davoir des fichiers préts a imprimer
avec plusieurs valeurs PPI, mais il serait utile de tenir compte des résultats
souhaités avant d'insérer n'importe quelle taille d'image.

72 PPl est la résolution standard de la plupart des écrans. Cela peut convenir
aux images numériques, mais le texte et les détails de I'image peuvent finir
par apparaitre déformés ou flous a I'impression. En regle générale, nous
recommandons un minimum de 150 PPI pour les images simples et 300
PPI pour les images complexes ou détaillées.

LULU GUIDE DE CREATION DE LIVRE CREATION DE FICHIER 5



Configuration des couleurs du document

Le RGB est un processus additif, ce qui signifie qu'il ajoute du rouge, du vert
et du bleu en quantités variables pour produire d'autres couleurs, tandis que
le CMYK est un processus soustractif qui utilise différentes quantités de cyan,
magenta, jaune et noir pour éliminer les couleurs réfléchies du papier afin

de créer d'autres couleurs visibles. Les deux processus ont des gammes de
couleurs différentes, le RGB offrant un plus large éventail de possibilités, c’est
pourquoi il est utilisé dans les appareils électroniques tels que les écrans
d'ordinateur. Limpression utilise le CMYK.

Par conséquent, on nous a dit de convertir les couleurs RGB en CMYK avant
denvoyer nos fichiers a imprimer. Il n"y aura aucun probléme si vous vous
en tenez a cette vieille habitude, mais les progres dans les flux de travail
d’impression font que ce n'est plus une nécessité.

Pourquoi les modéles Adobe InDesign sont-ils configurés en
RGB?

Les flux de travail modernes, comme notre processus chez Lulu,
permettent aux imprimantes d’utiliser des profils de couleurs qui associent
automatiquement I'encre CMYK aux valeurs RGB pour produire des résultats
similaires. Suivre ces quelques directives simples vous assurera une couleur
optimale dans votre livre :

1. Sivous partez de zéro, configurez votre document en tant que fichier
RGB.

2. Nous vous recommandons d’utiliser I'espace colorimétrique sRGB dans
le profil colorimétrique de votre document RGB et dappliquer I'espace
colorimétrique sRGB a toutes les images ou liens RGB avant de créer
votre PDF prét pour I'impression.

3. Sivous avez déja créé ou converti votre fichier en CMYK et converti
desimages en CMYK, conservez-le en CMYK et ne revenez pas en
RGB. La modification des parameétres de l'espace colorimétrique apres
la finalisation de votre fichier peut entrainer une variation de couleur
indésirable.

LULU GUIDE DE CREATION DE LIVRE CREATION DE FICHIER 6



4. Lesnoirs solides simprimeront a 100 % sans autres couleurs ajoutées.
Sivous ajoutez des couleurs pour améliorer la richesse du noir, le TAC
(couverture totale de la zone) ne doit jamais dépasser 270%.

5. Evitez les constructions de couleur trés claires de moins de 20 %. Une
variation de teinte inférieure a 20 % est tres difficile a contréler de
maniere cohérente.,

6. Sivousimprimez un livre couleur contenant des images en noir et
blanc, l'espace colorimétrique des images en noir et blanc doit étre
défini en niveaux de gris.

7. Le gamma d’'une image en niveaux de gris doit étre compris entre 2,2 et
24.

8. Utilisez uniguement des photos haute résolution (300 DPI ou plus) et
assurez-vous qu'elles sont cohérentes avec l'espace colorimétrique du
document, que vous utilisiez RGB ou CMYK.

9. Utilisez Iimpression intérieure Couleur premium et du papier premium
80# lorsque vous imprimez un livre contenant des photos ou des
images dans lesquels une forte couverture d’encre est utilisée et si vous
désirez un livre imprimé vibrant et coloré.

Profils d'espace colorimétrique de l'imprimante Lulu :

Il B B RGB:sRGBIEC61966-2.1
B B CMYK:Coated GRACoL 2006

LULU GUIDE DE CREATION DE LIVRE CREATION DE FICHIER 7



Anatomie d'un livre

Qulu Qulu

4EME DE COUVERTURE 1ERE DE COUVERTURE

Couverture de livre

Niulu

INTERIEUR

Intérieur du livre
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Termes de mise en forme

Taille totale du document
Les dimensions totales du fichier incluront le débord.

Zone du dos de la couverture

La largeur du dos de la couverture varie selon le nombre de pages que contient
votre livre. Utilisez la formule ou le tableau approprié pour déterminer la largeur
du dos de la couverture pour les livres a couverture rigide ou souple. Les livres a
couverture a spirale et a agrafes n'étant pas collés au dos, ils ne requierent pas de
calculs spécifiques.

Zone de confort

Nous recommandons de laisser une marge entre le bord rogné et un contenu
important (par ex, du texte, des images, les numéros de page) pour éviter un
rognage indésirable.

| Zone de débord
Une bordure est rognée sur les pages de livre imprimées durant le processus de
fabrication. Lesimages, textes ou autres éléments que vous souhaitez étendre
au bord de la page doivent remplir la zone de débord. Si un fichier est chargé
sans marge de fond perdu, Lulu doit ajouter une marge de 3,175 mm ou 0,125
po de tous les cotés pour permettre un rognage et une reliure appropriés. Voirla
section « Dimensions du fichier et fond perdu » (page 17)

Zone pour le code-barres (facultatif)

Il sagit de la zone recommandée pour accueillir votre code ISBN. Les livres non
destinés a la distribution globale nont pas besoin de code-barres ni de code ISBN.
Lulu ne génére ni najoute votre code-barres ou votre code ISBN a votre place.

Margine (page 70)
Marge intérieure pour les pages de l'intérieur du livre qui permet de tourner les
pages. Voir la section « Ajouts de marge » (page 10).

LULU GUIDE DE CREATION DE LIVRE CREATION DE FICHIER 9



Gouttiére

Qiulu

INTERIEUR

Ajouts de la gouttiére

Cela fait référence a un espace supplémentaire sur le coté reliure des pages
en regard pour tenir compte de la partie de la page insérée et collée dans la

Qiulu

INTERIEUR

reliure du livre. Les livres a reliure a spirale ne nécessitent pas de marge. Si

votre livre comprend plus de 150 pages, nous vous recommandons d'ajouter
une marge a votre travail. Si vous créez un livre broché ou relié, référencez le

tableau des ajouts de marge :

Nombre de pages

Inférieure a 60 Omm
61a150 3mm
1514400 13 mm
400 a 600 16 mm
Plus de 600 19 mm

LULU GUIDE DE CREATION DE LIVRE

Ajouter a la

marge intérieure

Marge intérieure
recommandée

13 mm

16 mm

25mm

29 mm

32mm

recommandée
(fond perdu)

16 mm
19 mm
29 mm
32mm

35mm

CREATION DE FICHIER
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Quand utiliser les dimensions de fond perdu

Inutile Oui Oui
Si l'ceuvre comporte Lorsque des images ou Il est important de préparer
principalement du texte du contenu s’étendent le fichier d’impression avec
ou a des marges blanches surle bord de la page, les des dimensions de fond
distinctes autour du corps, les  dimensions de fond perdu perdu pour les accents et les
dimensions de fond perdune  doivent étre utilisées lors images destinés a s’étendre
sont pas nécessaires. de la préparation de votre jusqu’au bord de la page.

fichier.

Dimensions du fichier et fond perdu

Lorsque les livres sont fabriqués, les fichiers sont imprimés puis découpés
selon les caractéristiques. Tous les fichiers du livre sont imprimés avec 3,175
mm ou 0,125 po de plus, de tous les c6tés, que la taille de coupe finale
afin de tenir compte du processus de rognage final. Pour les accents au bord
des pages, les arriére-plans et les fichiers, les meilleurs résultats proviennent
du rognage sur les ressources de la page.

Sivotre fichier formaté n'inclut pas d'images sétendant jusquau bord de
la page, vous pouvez préparer votre fichier a la taille finale du livre et notre
systéme ajoutera automatiquement une bordure de coupe.

Sivotre fichier formaté comprend des images, des fichiers ou du contenu
qui s’étend jusquau bord de la page, utilisez le tableau ci-dessous pour
déterminer les dimensions idéales du fichier intérieur.

Remarque :si une page de I'intérieur doit étre a fond perdu, toutes les
pages de l'intérieur utiliseront les mémes dimensions.

LULU GUIDE DE CREATION DE LIVRE CREATION DE FICHIER 11



Format

Poche

Digest

AS

Royal

Roman

Bande
dessinée

Exécutif

Crown Quarto

Petit carré

A4

Carré

Lettre US

Petit paysage

Lettre US
paysage

A4 paysage

Calendrier

Taille de coupe

4,25 po x 6,875 po
108 mmx 175 mm

55pox85po
140mmx 216 mm

5,83 pox 827 po
148 mmx 210 mm

6,14 pox 9,21 po
156 mmx 234 mm

6 po x 9 po
152mmx 229 mm

6,63 pox 10,25 po
168 mmx 260 mm

7 pox10po
178 mmx 254 mm

744 po x 9,68 po
189 mmx 246 mm

7.5pox7,5po
19T mmx 197 mm

827 pox 11,69 po
210mmx 297 mm

85pox85po
216 mmx216 mm

85pox11po
216 mmx 279 mm

9pox7po
229 mmx 178 mm

11 pox85po
279mmx216 mm

11,69 po x 8,27 po
210 mmx 297 mm

11 pox 85 po
279mmx216 mm

Dimensions du

fichier intérieur -

Sans débord

4,25 pox 6,875 po
108 mmx 175 mm

5,5pox 8,5 po
140mmx216 mm

5,83 pox827po
148 mmx 210 mm

6,14 pox 9,21 po
156 mmx 234 mm

6 po x 9 po
152mmx 229 mm

6,63 pox 10,25 po
168 mm x 260 mm

7 pox 10 po
178 mmx 254 mm

744 po x 9,68 po
189 mm x 246 mm

7,.5pox7,5po
19T mmx 197 mm

8,27 pox 11,69 po
210mmx 297 mm

85pox85po
216 mmx216 mm

85pox11po
216 mmx 279 mm

9pox7po
229 mmx 178 mm

11 pox85po
279mmx216 mm

11,69 po x 8,27 po
210 mmx 297 mm

11 pox85po
279mmx216 mm

Dimensions du
fichier intérieur -
Avec débord

45 pox 7,125 po
174mmx 1817 mm

5,75 pox 8,75 po
146 mm x 222 mm

6,08 po x 8,52 po
154 mmx 216 mm

6,39 po x 9,46 po
162 mmx 240 mm

6,25 po x 9,25 po
159 mm x 235 mm

6,88 pox 10,5 po
175mmx 267 mm

7.25pox 10,25 po
184 mm x 260 mm

7,69 pox 9,93 po
195mmx 252 mm

7,75pox 7,75 po
197 mmx 197 mm

8,52 pox 11,94 po
216 mm x 303 mm

8,75 po x 8,75 po
222 mmx 222 mm

8,75 pox 11,25 po
222 mm x 286 mm

9,25 pox 7,25 po
235mmx 184 mm

11,25 pox 8,75 po
235mmx 184 mm

11,94 po x 8,52 po
303 mmx216 mm

11,25 pox 8,75 po
286 mm x 222 mm

LULU GUIDE DE CREATION DE LIVRE
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Disposition de la couverture

Couverture générée par Lulu

Notre systeme insére les informations que vous fournissez pour créer une
couverture de livre convaincante avec le titre, le sous-titre, les contributeurs
et la description. C'est une excellente option rapide lorsque vous manquez
de temps ou avez simplement besoin de copies d'épreuve.

Créez et téléchargez votre propre couverture

Une fois que vous aurez téléchargé votre fichier intérieur, nous générerons
un modele de couverture que vous pourrez télécharger, concu sur mesure
selon les caractéristiques de votre livre. En créant votre propre couverture,
vous avez un controle total sur le contenu.

Guide pour la largeur du dos de la couverture

La largeur du dos de votre couverture est déterminée par le type de livre
que vous souhaitez créer ainsi que son nombre total de pages. Les livres
a couverture souple requierent un minimum de 32 pages intérieures

et l'utilisation d'une formule afin de trouver la juste largeur du dos de la
couverture. Les livres & couverture rigide requierent un minimum de 24
pages intérieures et I'utilisation d’'un tableau indiquant les fourchettes du
nombre de pages.

Remarque : Lulu vous propose un modele de couverture, une fois que

vous avez chargé le PDF de I'intérieur de votre livre, comprenant la taille du
dos de la couverture.

LULU GUIDE DE CREATION DE LIVRE CREATION DE FICHIER 13



Calculs de la largeur du dos

Couvertures souples
Utilisez la formule pour calculer la dimension de la largeur du dos
en pouces ou en millimeétres.

Largeur du dos en pouces =
(# de pages intérieures / 444) + 0,06 po

4
<
&

i
o
P

Largeur du dos en millimétres =
(# de pages intérieures / 17,48) + 1,524 mm

METRIQUE

Couvertures rigides
Utilisez le tableau pour déterminer la dimension de la
largeur du dos.

Nombre de pages Largeur du dos (pouces) Largeur du dos (mm)
0-23 N/A N/A
*24-84 0,25 po 6 mm
85-140 05 po 13 mm
141-168 0,625 po. 16 mm
169-194 0,688 po 17 mm
195-222 0,75 po 19 mm
223-250 0,813 po 217 mm
251-278 0875 po 22 mm
279-306 0,938 po 24 mm
307-334 1po 25 mm
335-360 1,063 po 27 mm
361-388 1,125 po 29 mm
389-416 1,188 po 30 mm
417-444 1,25 po 32 mm
445-472 1,313 po 33mm
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Nombre de pages Largeur du dos (pouces) Largeur du dos (mm)
473-500 1,375 po 35mm
501-528 1,438 po 37 mm
529-556 1,5 po 38 mm
557-582 1,563 po 40 mm
583-610 1,625 po 41 mm
611-638 1,688 po 43 mm
639-666 1,75 po 44 mm
667-694 1,813 po 46 mm
695-722 1,875 po 48 mm
723-750 1,938 po 49 mm
751-778 2 po 57 mm
779-799 2,063 po 52 mm
800 2,125 po 54 mm

Ajuster la largeur du dos

Lulu propose des modéles dans différents formats qui permettent la création
de couvertures dans le logiciel avec lequel vous étes le plus a laise. Vous
trouverez ci-dessous une bréve description de la facon dajuster la largeur
du dos a laide d’Adobe InDesign ou dAdobe Photoshop. Les modéles sont
également disponibles aux formats PDF et PNG. Chaque guide de dos de
modele de couverture est prédéfini a la largeur minimale. Gardez cela a
I'esprit lorsque vous ajustez votre dos.

Adobe InDesign
Utilisez l'outil de page pour ajuster la largeur de la page du dos.

1. Localisez l'outil Page dans le panneau Outils et sélectionnez-le.

2. Dansle panneau des pages, cliquez sur la page du dos (page 2 de la
planche). La page apparaitra en surbrillance dans le panneau des pages.
Spécifiez les parametres suivants dans le panneau de configuration
Mise en page liquide (Fenétre > Interactif > Mise en page liquide) :

LULU GUIDE DE CREATION DE LIVRE CREATION DE FICHIER 15



M Régle de la Mise en page liquide : Basé sur I'objet
M Contraintes d'objet : Redimensionner avec la page : Largeur

3. Aprés avoir déterminé vos dimensions de dos a l'aide de la formule
(couverture souple) ou du tableau de calcul (couverture rigide) figurant
dans ce PDF, redimensionnez la page avec les widgets Hauteur et
Largeur dans la barre de controle. La couverture entiére devrait se
mettre & jour automatiquement et est maintenant préte pour votre
illustration.

Remarque : le document doit étre configuré avec des pages en regard
vérifiées pour que la page de couverture avant soit automatiqguement
mélangée.

Adobe Photoshop
Ajustez la taille de la toile, révisez la largeur du dos et positionnez
les guides de couverture.

1. Soustrayez la dimension de largeur du dos minimale existante
indiquée sur la premiére de couverture de la dimension du dos trouvée
en utilisant la formule (couverture souple) ou le tableau de calcul
(couverture rigide) dans ce PDF et ajoutez cette valeur a la taille de la
toile. Allez dans Image > Taille de I'image et entrez la dimension de
largeur totale révisée.

2. Utilisez l'outil de sélection pour sélectionner le calque de forme du dos
dans le dossier des guides et entrez la dimension de largeur correcte
trouvée a l'aide de la formule ou du tableau de calcul du dos.

3. Alignez au centre le guide de dos, alignez a droite le guide de premiere
de couverture et alignez a gauche le guide de quatrieme de couverture
sur le document. Assurez-vous que les calgues du guide sont
correctement positionnés et qu’il N’y a aucun probléme.
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Concevoir le dos du livre

Le dos du livre peut se retrouver légérement déplacé durant la phase de
production. Pour cela, nous invitons les auteurs a suivre ces instructions
lorsqu'’ils créent leur couverture et, en particulier, lorsqu’ils préparent le dos
de leur couverture.

1. Le texte ajouté sur le dos de la couverture ne doit pas sy étaler sur
toute la largeur. En effet, le phénomene de déplacement risquerait de
faire déborder le texte ou sur la page de couverture ou sur la 4eme de
couverture. Laissez au moins un espace de 0,3175 mm ou 0,125 po
entre le texte du dos du livre et le bord du dos du livre de chaque coté
du texte.

2. Najoutez pas de texte lorsque vos projets de livre comprennent 80
pages ou moins. En effet, le cas échéant, le Iéger déplacement du
dos du livre entrainera le débordement du texte ou sur la page de
couverture ou sur la 4eme de couverture.

3. Evitez lesimages ou les couleurs unies/les forts contrastes de couleur
sur la page de couverture et/ou la 4éme de couverture quivont et
sarrétent juste au dos de la couverture. Il convient de garder la méme
couleur/habillage sur le dos de la couverture que celle/celui du reste de
la couverture.

4. Sile dos de votre couverture est caractérisé par une couleur autre que
celle du reste de la couverture, concevez cette derniére pour inclure
intentionnellement la couleur ou I'habillage du dos autour de la page de
couverture ou de la 4eme de couverture.

Rognage et variance

Il'y a des tolérances a prendre en compte lors de la conception de votre
intérieur et de votre couverture. Lors de la création de votre fichier, veuillez
suivre les instructions ci-dessous pour étre s(r que votre projet soit imprimé
convenablement. Notre tolérance de rognage est de 3,175 mm ou 0,125

po pour la premiére et la quatrieme de couverture. Si vous concevez votre
contenu sans oublier de laisser des marges et une marge de déplacement
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suffisantes, vous éviterez les problemes dalignement du texte au dos de la

couverture ainsi que de coupure du texte sur les bords de votre contenu.

| Bord de coupe

Clest le bord du livre imprimé final.

| Fond perdu

Les images doivent étre poussées vers le fond perdu, 3,175 mm ou 0,125
po au-dela du bord de coupe de chaque c6té.

I Zone de confort

Le texte et les autres éléments importants doivent étre placés a l'intérieur

de la zone de confort qui se trouve a 12,7 mm ou 0,5 pouce a I'intérieur du

bord de coupe. Cela garantira quaucun texte ne sera coupé en raison de

variations dans le processus de rognage.

Exemples de variance dans le rognage de couverture (pages 719-21)

Borders. Boundaries. Limits. Life is a continual process of
crossing borders and discovering something new. Collected
from a short fiction and non-fiction contest sponsored by Lulu
Press, the Crossing Borders Anthology contains stories about
overcoming obstacles; of physical, spiritual, and

emotional change and growth.
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Correct

Limage darriere-plan a été étendue de 3,175 mm ou 0,125 po au-dela du

bord de coupe et le texte et les illustrations importantes se trouvent dans le
cache.

| Borders. Boundaries. Limits. Life is a continual process of |
| crossing borders and discovering something new. Collected |
from a short fiction and non-fiction contest sponsored by Lulu
I Press, the Crossing Borders Anthology contains stories about | 1 0 1
overcoming obstacles; of physical, spiritual, and |
emotional change and growth. |
|
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Incorrect

Limage darriere-plan n'a pas été étendue au fond perdu. Cela pourrait
entrainer des bandes de blanc sur les bords de la couverture.

| Borders. Boundaries. Limits. Life is a continual process of |

crossing borders and discovering something new. Collected |

from a short fiction and non-fiction contest sponsored by Lulu

I Press, the Crossing Borders Anthology contains stories about |
|
|
|

overcoming obstacles; of physical, spiritual, and
emotional change and growth

SBN 978-1-79471-012-2

LI ] T

|

| |

= ]
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4éme de couverture  Dos du livre 1ére de couverture

Résultat de mise en forme incorrect
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Incorrect

Le texte de la quatrieme de couverture et le texte du dos n'ont pas été
conservés dans le cache. Cela pourrait entrainer la coupure du texte en

raison de tolérances lors du rognage.

discovering something new. Collected from a short fiction and non-fiction contest
fed by Lulu Reesspth ing-Borek contains steries-abqut
qvercoqing obstacles; of physical, spiritual, and emotional change and growth.
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iscovering something new. Collected from a short fiction and non-fiction contest
sonsored by Lulu Press, the Crossing Borders Anthology contains stories about
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Préparation du fichier

Lorsque vous téléchargez votre fichier intérieur dans le systéme Lulu, nous
analysons si votre ceuvre est adéquate a I'impression. En cas de décalage
Iéger, nous faisons quelques légers ajustements. Parfois, notre systeme
détermine qu'un grand changement est nécessaire. Si tel est le cas, nous
vous alerterons. Nous vous recommandons fortement de télécharger et
de revoir vos fichiers préts a imprimer avant de terminer le processus de
publication.

}Q Comment utiliser les options Adobe PDF (job options)
de Lulu

Lors de la création d’'un PDF avec les produits de la gamme
Adobe, utilisez les options Adobe PDF de Lulu (Job options). Les
fichiers d'options appliquent des paramétres prédéfinis lors de

I'exportation de votre PDF en fonction des exigences de nos
imprimeurs. Les fichiers des options (parameétres de page unique
pour lintérieur et de double-page pour la couverture) sont inclus
dans les modeles de conception Lulu qui se trouvent sur notre
page Produit.

Les fichiers des options PDF devraient s'installer
automatiquement quand vous ouvrez le fichier. Si cela n'est pasle
cas, vous pouvez les installer manuellement :

Adobe InDesign

1. Choisissez Sélectionner fichier (Choose File) >
Paramétres Adobe PDF (Adobe PDF Presets) > Définir
(Define).

2. Cliquez sur Charger (Load) et sélectionnez le fichier
joboptions a utiliser.

3. Exportez votre fichier, sélectionnez les options de Lulu
dans la liste déroulante de parameétres Adobe PDF
(Adobe PDF Presets) pour I'exporter en PDF en utilisant
les parameétres des options PDF de Lulu.

LULU GUIDE DE CREATION DE LIVRE SOUMISSION DE FICHIER

23



. Adobe Photoshop

1. Choisissez Edition > Parametres prédéfinis Adobe PDF
(Edit > Adobe PDF Presets).

2. Cliquez sur Charger (Load) et sélectionnez le fichier
Jopoptions.

3. Utilisez Enregistrer sous PDF Photoshop et
sélectionnez les parametres joboptions dans la liste
déroulante.

J< Adobe Acrobat Distiller

1. Choisissez Parametres (Settings) > Ajouter des
parametres Adobe PDF (Add Adobe PDF settings).

2. Naviguez vers le fichier joboptions et cliquez sur OK.

3. Les nouveaux parametres seront disponible dans
la liste déroulante “Paramétres par défaut” (Default
Settings). Assurez-vous de les sélectionner avant
d'importer votre fichier Postscript (PS).

Caractéristiques du fichier intérieur

Lors de la création de votre livre avec Lulu, vous devez fournir un seul PDF
contenant tous les éléments de l'intérieur du livre. Y compris les pages de
titre, de copyright ainsi que d’éventuelles pages blanches si vous le souhaitez.

¢ Format page unique, orientation portrait

* Lesimages contenues dans le livre doivent avoir une résolution
comprise entre minimum 300 PPI et maximum 600 PPI

* Lesimages vectorielles sont rasterisées

* Toutes les polices sont diment incorporées

* Les couches transparentes et les objets vectoriels sont aplatis

* Pages dimensionnées pour correspondre a la taille du livre voulue -
comprend les dimensions du débord (3,175 mm ou 0,125 po) avec la
taille de la page de votre PDF:
Exemple : un livre de 152 mm x 229 mm ou 6 x 9 pouces requiert un
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PDF avec des pages de dimensions de 159 mm x 235 mm ou 6,25 x 9,25
pouces afin d’étre conformes aux exigences d’impression de bords perdus
Laissez une marge de sécurité minimum de 12,7 mm pour chagque contenu
Laissez une marge minimum de 5,08 mm pour chaque bord intérieur de
page

Ne considérez PAS le rognage, le débord ou encore les lignes de marge
N'utilisez PAS de protection de fichiers de sécurité / mot de passe

Caractéristiques du fichier de couverture
Votre PDF doit étre un seul et unique fichier et contenir tous les éléments de

votre couverture. Lulu vous proposera un modeéle de couverture contenant

les dimensions exactes du dos de la couverture une fois que vous aurez

chargé le PDF de l'intérieur de votre livre. Nous vous recommandons

vivement d’utiliser le modeéle proposé pour étre sCr que le PDF de votre

couverture soit imprimé et rogné convenablement.

Lesimages contenues doivent avoir une résolution comprise entre
minimum 300 PPl et maximum 600 PPI

Les images vectorielles sont rasterisées

Toutes les polices sont diment incorporées

Les couches transparentes et les objets vectoriels sont aplatis

Pages dimensionnées pour correspondre a la taille du livre voulue — voir
page 13 pour le calcul de la largeur du dos du livre

Incluez les dimensions du débord (3,175 mm) dans la taille de page de
votre fichier PDF

Laissez une marge de sécurité minimum de 12,7 mm pour chague
contenu

Ne considérez PAS le rognage, le débord ou encore les lignes de marge
N'utilisez PAS de protection de fichiers de sécurité / mot de passe
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Couvertures de magazines et de bandes dessinées
Sivous souhaitez créer un magazine ou encore une livre de bande dessinée,
vous pouvez choisir d'imprimer sur la 2éme et la 3éme de couverture. Ce
type d'impression nécessite un fichier contenant une couverture sur deux
pages. Pour en savoir plus a ce propos, consultez le modeéle de couverture
pour magazine et bande dessinée.

Epreuvage

Lune des étapes les plus importantes (et souvent négligée) du processus
de publication est peut-étre lapprobation finale de I'épreuve. Cela signifie
que vous avez chargé, imprimé et recu une copie physique de votre travail
comme un lecteur la recevrait. La vérification de vos documents imprimés
est essentielle pour rectifier et identifier les erreurs. Vous pouvez découvrir
les problémes suivants lors de la vérification :

Erreur humaine

Parfois, lorsque vous travaillez dans un délai imparti, vous n'avez pas le temps
d’examiner entiérement votre fichier complet avant d'imprimer. Lors de la
réception de votre épreuve, vous remarquerez peut-étre des fautes de frappe
ou des problemes de mise en page. La meilleure solution est de modifier

le fichier intérieur, de le charger a nouveau et de commander une nouvelle
copie dépreuve.

Errore del file

Une faible résolution d'image, des transparences et des polices non
intégrées sont des problémes courants qui peuvent ne pas étre évidents
lors de la visualisation de votre manuscrit sur un écran. Bien que notre
systeme détecte et résolve bon nombre de ces problémes, certains peuvent
passer inapercus. Si vous découvrez une erreur dans votre livre imprimé qui
napparait pas dans votre fichier électronique, veuillez nous contacter sur
pour obtenir de laide.
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Variance d'impression

Tous les fabricants sefforcent de produire des produits 100 % précis.
Toutefois, comme dans n'importe quel procédé mécanique, il peut y avoir
des écarts de production. Notre marge de tolérance de rognage est de
0,3175 mm vers la page de couverture et la 4éme de couverture. Si vous
concevez votre contenu sans oublier de laisser des marges et une marge de
déplacement suffisantes, vous éviterez les problémes d'alignement du texte
au dos de la couverture ainsi que de coupure du texte sur les bords de votre
contenu.

Erreur de production et d'expédition

Notre objectif est d'imprimer, de relier et de livrer des livres de la plus haute
qualité possible ; cependant, en raison de la nature de la production de livres
Sur mesure, NoUs Ne pouvons pas garantir la perfection pour chaque livre. Si
votre livre est plié, déchiré ou présente dautres dommages de fabrication ou
d’expédition, veuillez nous contacter sur pour obtenir de l'aide.

Klulu
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